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Notices  

This document contains information proprietary to 
FileNET Corporation (FileNET). Due to continuing 
product development, product specifications and 
capabilities are subject to change without notice. You 
may not disclose or use any proprietary information or 
reproduce or transmit any part of this document in 
any form or by any means, electronic or mechanical, 
for any purpose, without written permission from 
FileNET. 
 
FileNET has made every effort to keep the 
information in this document current and accurate as 
of the date of publication or revision. However, 
FileNET does not guarantee or imply that this 
document is error free or accurate with regard to any 
particular specification. In no event will FileNET be 
liable for direct, indirect, special incidental, or 
consequential damages resulting from any defect in 
the documentation, even if advised of the possibility 
of such dam-ages. No FileNET agent, dealer, or 
employee is authorized to make any modification, 
extension, or addition to the above statements. 
 
FileNET may have patents, patent applications, 
trademarks, copyrights, or other intellectual property 
rights covering subject matter in this document. 
Furnishing this document does not provide any 
license to these patents, trademarks, copyrights, or 
other intellectual property. FileNET is a registered 
trademark. Copyright © 2002 FileNET Corp. All 
Rights Reserved. 
 
 

All other brands, products, and company names 
mentioned are trademarks of their respective 
owners. 
 
Please take a few moments to read the License 
Agreement in “Appendix B –Software License 
Agreement” Page 134. By installing the Panagon 
software, the customer agrees to be bound by the 
terms of this agreement. 
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About this Manual 

This manual provides information about installing and configuring CRM 
Integration Suite 3.0 product. 

Conventions Used in this Document 
 

Education 

FileNET provides various forms of instruction. Please visit the Global 
Learning Services in FileNET's Service & Support area at 
www.filenet.com. 

Comments and Suggestions 

FileNET invites all customers to communicate with the Documentation 
group on any question or comment related to FileNET manuals and 
online help. Fax, phone, mail, or email any question or comment to Mike 
Calvert at one of the numbers or addresses listed below. We guarantee a 
response to each communication within one week. Your suggestions help 
us improve the products we deliver.  
Mike Calvert 
Director of Documentation 
FileNET Corporation 
3565 Harbor Boulevard 
Costa Mesa, California 92626-1420 
Phone:714.327.3449 
Fax:714.327.5076 
email: mcalvert@filenet.com
 

http://www.filenet.com/
mailto:mcalvert@filenet.com
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1 
 Before You Install  

This Installation and configuration manual describes procedures for 
installing and configuring CIS 3.0 application. 
Prior to beginning the installation, we recommend that you: 
 

• Read all overview information, installation procedures and 
configuration procedures. Setting up CIS 3.0 system is a multi-
part process; you should understand the steps required before 
beginning the procedures. 

− “CIS 3.0 an Overview”  

− “Overview of the Installation Process”  

− “Application Configuration”  

− “Appendix A – Single Sign-on, Delete All Links functionality 

− “Appendix B – License agreement 

− Read the Release Notes. You can find the release notes 
on the FileNET website at http://www.css.filenet.com. 

• Be prepared to reference additional documents as needed. 
For example, any further detail about Siebel can be found from 
Siebel Bookshelf and details about Open Client can be found 
from the documentation provided with the open client. 

 

http://www.css.filenet.com/
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CIS 3.0 an Overview 

FileNET CIS 3.0 application is a set of integration modules that enables 
Siebel users to seamlessly store and access documents stored in the 
FileNET Panagon IDM repositories.  

CIS 3.0 application interacts with the following servers 

Siebel Server 

Siebel server hosts Siebel 7.0.4.23 Enterprise Server installation and all 
CIS custom objects for Siebel. Open Client and Siebel Enterprise Server 
may be installed on same Hardware server. CIS custom Siebel objects 
provide interface to CIS application and are deployed on the machine 
during CIS 3.0 installation 

Open Client Server 
This server hosts FileNET Open Client GA release installation and all CIS 
web pages, assemblies and DLLs. These CIS files are deployed on this 
machine during CIS 3.0 installation. Open Client server must have Siebel 
dedicated web client installation. 

Note For Siebel 7.0.4 dedicated web client installation and Open client GA 
release installation, refer to Siebel Bookshelf and Open Client 
documentation respectively. 

IS / CS Servers 
 

CIS application interacts with Image Services and Content services 
through FileNET Open Client application for storing and retrieving stored 
documents.  

User Workstations 
  

Siebel user accesses CIS 3.0 application from workstation through Siebel 
client interface using Internet explorer browser.   
Refer to Siebel bookshelf for IE versions supported by Siebel. 
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Warning  CIS application will stop working if Open client is uninstalled.  
Uninstall CIS before uninstalling Open Client. 

CIS 3.0 Tools 

CIS 3.0 suite comes along with following two helper tools: 

CIS 3.0 Configuration Tool – This tool is used for configuring CIS 3.0 
application and Database. 

CIS 3.0 Migration Tool- This tool is used for migrating data from CIS 2.1 
database to CIS 3.0 database.  

System Prerequisites 
All systems must meet the hardware, software and (as necessary) 
configuration requirements described in the following sections.  
CIS 3.0 installation requires pre-installed  

� FileNET Open Client server  
� Siebel Enterprise server  

Note:  Siebel Enterprise server and FileNET Open Client Server may co-exist on the 
same Hardware & IIS server. 

Hardware / Software requirements for CIS application are as follows 

CIS 3.0 Application 

Hardware 

• P-IV machine 1.5 Ghz class processor & above 

• 1.5 GB disk space  

• Minimum 512 MB RAM (1 GB RAM recommended) 

Software 

• Windows 2000 Server with service Pack 2 

• Internet Information Server 5.5 

• Siebel 7.0.4.23 Enterprise server 

• Siebel 7.0.4 dedicated Client 

• IDM Web Services 3.2 
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• .NET Framework 

• Open Client GA release 

• SQL Server 2000 Client or Oracle 8i Client 

Warning  It is recommended to install the software in the sequence mentioned 
above.  

CIS 3.0 Database  

Hardware 

• Min 100 MB disk Space 

Software  

• SQL Server 2000 or Oracle 8i Database 
 

Note Open Client server and Siebel Enterprise server must have connectivity 
to CIS 3.0 database. 
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2 
 Installation 

This chapter provides information, instruction and guidelines for installing 
CIS3.0 application. 

Installing CIS3.0 application  

Launch setup.exe to install CIS3.0 application, following screen will 
appear: 

Note:   Ensure IIS is shutdown before executing CIS 3.0 set-up program 
to ensure proper installation, update and un-installation. 

 
 

There are 4 options provided on the splash screen. These options are as 
follows: 

1. View Documents - This option facilitates user to view all CIS 
3.0 documents. There are 3 documents provided with this CIS 
release viz. Installation Guide, Operations manual and 
Readme file. 

2. Setup for Open Client – Select Setup for Open Client to 
install CIS components on Open Client Server. This setup 
program checks whether FileNET Open client is installed on 
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the machine. If it does not exist, CIS3.0 installation process 
exits. 

3. Setup for Siebel Server – Select Setup for Siebel Server to 
install CIS components on Siebel server. 

Note   CIS 3.0 installation is two-step process that includes CIS3.0 
components installation on Open Client Server and Siebel Server 
machine. This process facilitates CIS 3.0 application installation 
on a separate hardware other than the Siebel Server m/c. 

4. Click on Exit button to exit from the setup program 

 View Documents 
Click on View Documents, following screen will appear. 

 
 

Click on appropriate option to view documents. To view all CIS3.0 
documents Acrobat Reader must be installed on the system.  
Click on Exit to go back to the previous screen. 

Setup for Open Client 
To install CIS components on Open Client server, click on Setup for 
Open Client.  On selection of this option following screen will appear 
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To continue, click on Next button. Following screen will appear 
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To accept the License agreement, click on Yes button. Following screen 
will appear. 

 

 
 
To continue, click on Next button. Following screen will appear 
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Enter Customer Information i.e. User name and Company Name. To 
continue, click on Next button. Following screen will appear 

 

 
  

Choose CIS 3.0 set-up type.  To continue, click on Next button. Following 
screen will appear 

 
Typical  Choose this setup type to install all CIS 3.0 components 

with most common options. This option skips installation of 
user documentation for CIS3.0 and Acrobat Reader. 

 
Custom  This setup option lets you customize your installation by 

choosing the specific components you want to install. 
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Select the features to be installed in CIS 3.0 setup.  To continue, click on 
Next button. Following screen will appear 

Note  This screen will appear only if Custom set-up type is chosen in the 
previous screen. For Typical set-up type, skip to next screen. 
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Enter the Folder name for CIS3.0 application. CIS 3.0 application will 
appear with this name under Program Files folder of windows. Default 
folder name given is ‘FileNET CRM integration Suite 3.0’. 
 
To continue click on Next button, following screen will appear 
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Verify the information provided in the previous screen.  Click on Back 
button to modify the information.  
To continue, click on Next button. Following screen will appear 

 
 

This screen will be followed by Microsoft Internet Explorer WebControls 
Setup screen. 

Note:   This setup wizard will appear only if Microsoft Internet Explorer 
WebControls is not installed on the installation machine. 
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To proceed, click on Next Button. Following Screen will appear. 

 
Accept License Agreement and click on Next button. Following screen 
will appear. To cancel the setup, click on Cancel button. 
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Note:  For successful installation of CIS 3.0, install Microsoft Internet 
Explorer Web Controls version 1.0 

 
To start the installation, click on Next button. Following screen appears. 
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This screen will be followed by installation completion screen. 

 
 
Click on Close button. This ends the installation of Microsoft Internet 
Explorer WebControls. CIS 3.0 Configuration screen will appear. 

 
Enter administrator logon credential i.e. User Name and Password for 
CIS 3.0 configuration tool.  
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Note These credentials will be required to logon to configuration tool. 

To continue, click on Next button. Acrobat Reader installation screen will 
appear. 

 
Select appropriate option. To continue, click on Next button. Following 
screen will appear 

 
Select restart option and click on Finish button. The server is rebooted. 
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Note  Server must be restarted after successful installation. 

Note   Create CIS 3.0 Database before proceeding further. CIS 3.0 
Database creation steps are provided in Creating CIS 3.0 
Database chapter. 

Setup for Siebel 
Launch setup.exe on Siebel Server machine, Following screen will 
appear: 
 

 
 

To install CIS setup for Siebel Server, click on Setup for Siebel Server.  
On selection of this option following screen will appear 
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To continue, click on Next Button. Following screen will appear  

 
 To accept the License agreement, click on Yes button. Following screen will 
appear. 
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To continue, click on Next button. Following screen will appear 
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Click on Browse button to select appropriate destination folder. To 
continue, click on Next button. Following screen will appear 

 
 

Verify the information provided in the previous screen.  Click on Back 
button to modify the information.  
To continue, click on Next button.  Following screen will appear 
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This screen is followed by CIS 3.0 database Configuration screen. 

 
Select appropriate database type for CIS 3.0 database and click on Next 
button.  

• For Database type ORACLE following screen will appear 
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Provide TNS name for CIS 3.0 database and click on Next Button 

• For Database type SQL Server following screen will appear 

 
Provide Database server name and database name for CIS 3.0 database. 
To proceed, click on Next Button. Following screen will appear. 



  CIS 3.0 Installation and Configuration Guide 

October 2002 FileNET CRM Integration Suite 29 

 
Provide CIS 3.0 Database logon credentials i.e. User Name and 
Password. Confirm the password by re-entering it.  
Click on Next button, Open client server configuration screen will appear. 
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Enter Open Client Server name and Open Client virtual directory 
name. Open Client virtual directory name is the name of the virtual 
directory that provides access to Open Client. 
Open Client virtual directory name can be picked from windows registry 
by looking for ‘IDMWSXVDir’ key value under HKEY_LOCAL_MACHINE/ 
FileNET /IDM /Web_Specific folder. 

Note Default values for Open Client Server name will be the local server name 
and Open Client virtual directory name will be Open Client’s virtual 
directory name on the machine, if available. 

To continue, click on Next button. Following screen will appear. 

 
 
To continue, click on Finish. Following screen will appear 
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Exit 
Exit option will close the setup program. 

Modifying CIS3.0 Application 

Modify Setup for Open Client 
To modify CIS 3.0 setup for Open Client navigate to Start->Settings-
>Control Panel->Add /Remove Programs 
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Select program FileNET CRM integration Suite 3.0 and click on 
Change/Remove Button, following screen will appear 
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Select Modify option. To continue, click on Next button. Following screen 
will appear 

 
Select components to be modified.   
To continue, click on Next button. Following screen will appear 
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This screen will be followed by Setup completion screen 

 
Click on Finish button. 

Modify CIS 3.0 Setup for Siebel Server  
To modify CIS 3.0 setup for Siebel server navigate to Start->Settings-
>Control Panel->Add /Remove Programs 
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Select program CIS 3.0 Setup for Siebel Server and click on 
Change/Remove Button, following screen will appear 

 
Select Modify option and click on Next button. Following screen will 
appear. 
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Select setup options to be performed.  By default, both the option will be 
selected. 
To continue, click on Next button. Following screens will appear 

 
This screen will be followed by Database configuration screen. 
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Select appropriate Database type for CIS 3.0 database and click on Next 
button.  

• For Database type ORACLE following screen will appear 

 
Provide TNS name for CIS 3.0 database and click on Next Button 

• For Database type SQL Server following screen will appear 
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Provide Database server name and database name for CIS 3.0 database. 
To continue click on Next Button, following screen will appear. 

 
Enter CIS 3.0 Database logon credentials i.e. User Name and Password. 
Confirm the password by re-entering it. Click on Next button, Open Client 
Server configuration screen will appear. 

Note  Screens related with the database configuration will appear only if 
Configure Database for CIS 3.0 application option is selected. 
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Enter CIS 3.0 Server name and Open Client virtual directory name.  
To continue, click on Next button. Following screen will appear 

 
 

 
Click on Finish button. 

Removing CIS3.0 application 

Remove CIS 3.0 Setup for Open Client 
To remove CIS 3.0 setup for Open Client navigate to Start->Settings-
>Control Panel->Add /Remove Programs 
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Select program CIS 3.0 Set-up for Open Client and click on 
Change/Remove Button, following screen will appear 
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Select Remove option and click on Next Button. Following screen will 
appear. 
 

 
 

Click on Ok button to Confirm removal of CIS 3.0 installation. Following 
screen will appear. 

 
This screen will be followed by process completion screen. 
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Click on Finish button. 

Remove CIS 3.0 Setup for Siebel Server 
To remove CIS 3.0 setup for Siebel server navigate to Start->Settings-
>Control Panel->Add /Remove Programs 
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Select program FileNET CRM integration Suite 3.0 for Siebel Server 
and click on Change/Remove Button, following screen will appear 

 
Select Remove option and click on Next Button. Following screen will 
appear. 
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Click on Ok button to Confirm removal of CIS 3.0 installation. Following 
screen will appear. 
 

 
This screen will be followed by process completion screen. 
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Click on Finish button. 
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3 
Creating CIS3.0 Database 

As a part of CIS 3.0 installation, CIS 3.0 database scripts and batch files 
to run these scripts are copied in SQLScripts subfolder under CIS 3.0 
installation folder.   
There are two batch files, one is for ORACLE 8i RDBMS and other one is 
for SQL server 2000 RDBMS. Execute the appropriate batch file to create 
CIS database objects.  

Note:   CIS 3.0 database objects and CIS 2.1 database objects cannot be 
stored in the same database instance. Steps to create CIS 3.0 
database are provided below and must be adhered to for proper 
functioning of CIS 3.0 application.  

Creating CIS database in ORACLE 8i 
Pre-Requisites 

a. ORACLE server where CIS 3.0 database will reside 
b.  Database instance for CIS3.0  
c. Tablespace named CIS30 to hold all CIS tables 

and indexes 
d. An account with the privilege to create objects in 

this Tablespace 
e. TNS to connect to CIS30 Tablespace 
f. Connectivity to the ORACLE database, using tool 

SQL Plus. 
From DOS command prompt execute CIS3.0OracleScripts.bat with 
three input parameters TNS name, user id and password delimited by 
space. The following is the syntax  

CIS3.0OracleScripts.bat <TnsName> <User Id> <Password> 
Creating CIS database in SQL Server 2000 
Pre-Requisites 

a. MS-SQL Server where CIS 3.0 Database will reside 
b. Database named CIS30 
c. CIS 30 DB user having db_owner role. 
d. Connectivity to MS-SQL Server using Query 

Analyzer 
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From DOS command prompt run CIS3.0SQLScripts.bat with three input 
parameters SQL Server name, user id and password delimited by space. 
The following is the syntax  

CIS3.0SQLScripts.bat <SQL Server name> <user id> <password>.  
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4 
Application Configuration 

CIS 3.0 application requires some basic application and database 
configuration before it is ready to be used.  
Following steps are required to configure CIS 3.0 application using 
configuration tool 
� Accessing CIS 3.0 Configuration tool 
� Logon to configuration tool 
� Current settings  
� General settings 
� Database settings 
� Panagon settings 
� Siebel settings 
� Configuring CIS 3.0 Database 
� Changing password for configuration tool 

Accessing CIS 3.0 Configuration tool 

Navigate from windows explorer to Start -> Programs->FileNET CRM 
Integration Suite 3.0-> Configuration Tool   
 Or 
Opening URL http://<OpenClientServerName>/<OpenClient Alias 
name>/CIS from your web browser 
CIS 3.0 Configuration Logon Screen appears.   

Logon to configuration tool 

 

http://<cisservernameopenclientservername>/<OpenClient Alias name>/CIS
http://<cisservernameopenclientservername>/<OpenClient Alias name>/CIS
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Enter valid logon credentials and configuration option. To continue, click 
on OK. Following screen will appear 

 

Note  Configuration parameters which have got asterisk ‘*’ as prefix are 
mandatory and values for these parameters must be provided 
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Current Settings 

 
 
The text area Current Settings lists the current configuration settings. 

General Settings 

 
The following general settings are configurable: 
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Error Log Path:  

 
Specify the complete path of the folder for CIS 3.0 error Logs Default 
error log folder is /Errorlog under CIS 3.0 application installation folder. 
The error logs are generated for each day and are stored in text files in 
the format CISError<mm_dd_yyyy>.log 

Note If specified Error Log folder does not already exist, folder will be created 
by CIS 3.0 application. 

Session Time Out:  

 
Specify the value for Session Time Out.  The maximum value that can be 
specified is 1000 Minutes.  While working with CIS Application, all 
unsaved data will be lost once the user is idle for the maximum value 
specified for session time out. 
Display Document Properties:   

 
By default this option is checked. This option is required to display 
configured FileNET indices. 
When unchecked following fields are displayed for all documents while 
viewing the document details: 

• Document ID 

• Entry Date 

• Pages 
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Enable View Menu Option:   

 
By default this option is checked. Check this checkbox to provide ‘View’ 
Button on CIS web pages. Click on ‘View’ Button opens the selected 
document in IDM Viewer. 
Open Single Linked Document:  

 
Check this checkbox to enable the facility of automatically opening of a 
single linked document for a document class.   
Default Viewing Action:  

 
Specify Default Viewing Action.  
View: Facilitates opening the selected document in IDM viewer 
Open: Facilitates opening of selected document in JAVA viewer provided 
selected document MIME type is supported by JAVA viewer else it opens 
the document in Native application. 
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Interactive Mode:  

 
Specify interactivity mode for CIS 3.0 application.  
High – High Interactivity support an implicit save whereby navigating off a 
record causes the changes to be saved. 
 
Standard- Standard Interactivity supports an explicit save operation for 
each record to commit the changes. 
 

Database Settings 

 
 

CIS 3.0 supports Oracle 8i and SQL Server 2000 for CIS database.   

Specify database type by selecting appropriate option  
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If selected database type is Oracle, 

 
Specify the following values required for logon 
User ID:  A valid User ID of the user with access to CIS database and 
has insert/update/delete rights on CIS tables. 
Password: Specify the valid password for the user specified in User ID 
textbox. 
TNS Name:  Specify the TNS Name to connect to CIS database. TNS 
name is defined in TNSNAMES.ORA file in Oracle. 
 
If selected database type is SQL Server,  

 
Please specify the following values required for logon 
User ID:  A valid User ID of the user with access to CIS database and 
has insert/update/delete rights on CIS tables. 
Password: Specify the valid password for the user specified in User ID 
textbox. 
Server Name: Specify the Server name on which the SQL Server 
database has been setup. 
Database Name: Specify the name of CIS Database. 
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Panagon Settings 

 
SSO Enabled:  To use Single Sign on mechanism for FileNET logon, you 
should check SSO check box. To know more about ‘SSO ‘, refer to 
section “Single Sign On” in Appendix A. 
LDAP Server Name: LDAP server name is required only when SSO 
Enabled option is checked. Specify LDAP server name that is being used 
by Siebel and FileNET for external authentication.  
Preferred Library: Specify the library, which will be most frequently used 
by CIS 3.0 users. This library will be default library for all CIS operations. 
These IDM libraries are configured on the system using IDM configure 
Tool. 
 
User Name:  Specify the user name to be used to login into the preferred 
FileNET library. This value is required only when SSO mode is disabled 
i.e. is not checked. 
Password: Specify the password for the user mentioned above. This 
credential is required only when SSO mode is disabled, by CIS 
application to login into the preferred FileNET library. 
Group:  Specify the group in the preferred FileNET Library to which the 
user belongs. Group name is required only if preferred library is CS 
library. 

Note User will be logged on to FileNET Library with the specified group or 
default group, if not specified. 
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Siebel Settings 

 
 

Siebel Connect String:  Siebel connection string is the connection string 
that is used to connect to Siebel server. Default connection string is 
siebel.TCPIP.NONE.none://<SiebelServerName>:2320/siebel/SCCObj
Mgr/<SiebelServerName> 
Replace <SiebelServerName> by actual Siebel Server name. 
This connection string can be picked from appropriate application section 
of eapps.cfg file that lies in SWEApp folder under Siebel folder.  
i.e. if CIS modules is integrated to Call Center application, pick up the 
connection string from [\Callcenter] section. 
User Name: Specify Siebel user name which will be used to connect to 
Siebel. 
Password: Specify password for the above-mentioned Siebel user. 
These credentials will be used to connect to Siebel. 
To save the changes click on Save.  To restore the previous settings click 
on Cancel button.  

Note:  Close Configuration Tool and restart IIS to reflect the configuration 
changes in CIS application. 

Changing password for Configuration tool 

To change password for Configuration Tool administrator, launch the 
Configuration Tool screen. Enter valid logon credentials and click on 
Change Password button. Following screen will appear 
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Specify the new password in the New Password field and re-enter the 
new password in the Confirm New Password field.  To save the new 
password, click on Save.  To cancel the operation, click on Cancel. 
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5 
    Database Configuration 

Administrator must configure CIS database before using CIS 3.0 
application.  CIS application will allow operation on only those Siebel 
objects and FileNET objects that are configured in CIS 3.0 database.   
Following steps are required to configure CIS 3.0 database using 
database configuration tool 
� Configure Siebel Fields 
� Configure FileNET Fields 
� Map FileNET with Siebel Fields 
� Configure Parent Business Components 

Database configuration tool can be accessed from CIS 3.0 configuration 
logon screen by selecting CIS 3.0 Database Configuration option from 
Select option drop down. 

 
 
Enter valid logon credential and select CISS 3.0 Database configuration 
option in Select Option drop down and click on Ok button. Following 
screen will appear. 
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This screen facilitates user to view and configure mapping between 
FileNET fields and Siebel fields that are configured for CIS 3.0 
application.  
Steps to map FileNET with Siebel Fields is explained later in the section 
“Map FileNET with Siebel Fields” 
Following are the configurations required for CIS application 

Configure Siebel Fields 

CIS application works on two Siebel objects: Siebel Business component 
and Siebel business component field. CIS can perform operation on only 
those Siebel objects, which are configured in CIS database.  
Database configuration tool provides interface to configure Siebel 
Objects.  
Select Configure Siebel Fields option from Select option drop down. 
Following screen will appear. 
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This screen shows existing configured business component name and 
business component fields in the list view. 
To configure Siebel objects for CIS database, follow these instructions 

• Select Business Component name from Select Business 
Component drop down.   

• Select Business component field name from Select Siebel Field drop 
down. This drop down contains all Siebel field pertaining to the 
selected Business Component. 

• Click on Add button. Selected business component and business 
component field will get configured and selected pair will be added 
into the list view. 

• To delete a configured Siebel Business Component field from CIS 
database, select the respective row and click on Delete link.  Selected 
row will be deleted from the list view. 

Configure FileNET Fields 

CIS application works with the following IDM objects: FileNET library, 
Document class and document class field. CIS application can perform 
operation on only those FileNET objects, which are configured in CIS 
database 
Select Configure FileNET Fields option from Select Option drop down. 
Following screen will come up.  
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All configured libraries, document classes and document class fields will 
appear in the list view. 
To configure FileNET objects, follow these instructions 

• Select a FileNET library from Select Library drop down.   

• Select Document class from Select Document Class drop down. 
This drop down contains all document classes pertaining to the 
selected FileNET library. 

• Select document class field from Select Document Class Field drop 
down. This drop down will contain all document class fields pertaining 
to the selected document class and library combination.  

• Click on Add button. Selected library, document class and document 
class field will get configured and selected pair will get added into the 
data grid.  

• To delete a configured document class field from CIS database, select 
respective row from the data grid and click on Delete Link.  Selected 
row will be deleted from the data grid  
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Map FileNET with Siebel Fields 

Select Map FileNET with Siebel Fields option. Following screen will 
come up. 

 
To map FileNET with Siebel fields, follow these instructions  

• Select library name, document class and document class field from 
Select Library, Select document class and Select document class 
Field drop downs respectively. 

• Select business component name and business component field 
name from Select business Component, Select Business 
Component Field drop downs respectively. 

• Click on Add button. FileNET field and Siebel field will get mapped 
and mapped FileNET-Siebel object pair will get added to the data grid.  

• In order to delete mapping between a Siebel Business Component 
field and Document class field, select the map row from the data grid 
and click on Delete link, mapping will be deleted and row will be 
deleted from the data grid. 
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Configure Parent Business Component 

CIS 3.0 application allows to link documents to parent business 
component of the selected business component. To configure parent 
Business Component for a configured business component, select 
Configure Parent Business Component option. Following screen will 
appear. 

 

 
 

The above screen shows configured parent business component and its 
foreign keys for a configured business component. 
To configure parent business component for a configured business 
component, follow these instructions 

• Select configured Siebel business component from Select Business 
Component drop down.  

• Select parent business component from Select Parent Business 
Component drop down. 

• Select a foreign key from Select Foreign key drop down. 

• Click on Add button. For the selected Business Component, parent 
business component will be configured along with its foreign key. 
Selected business component, parent business component and 
foreign key pair will get added to the list view.  

• To delete a configured foreign key for a Business component and 
parent business component pair, click on Delete link. Entry will be 
deleted from the list view. 

 
To go back to CIS 3.0 Configuration Tool home page, click on Logoff button. 
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6 
  CIS-Siebel Integration 

In order to integrate CIS modules inside Siebel Call Center application interface, 
following steps will need to be performed. 
  
Importing Custom CIS Objects – This process will import custom CIS objects in 
Siebel repository 
Importing CIS Scripts – This process will import custom CIS scripts in Siebel 
repository.  
Copying web template - CIS applets are based on custom CIS web templates. In 
order to use these templates, templates should be copied in < system drive > 
/sea703/siebsrvr/webtempl 
Set CISVBC as Business Object component to Service Request Business Object 
– In order to integrate CIS views inside Service screen, CIS VBC should be set 
as business object component to Service Request business object.  
Adding CIS Views to Service Request Screen – This process explains how to 
integrate CIS views in Service request screen 
Compiling the repository  - This process is required to get the custom objects 
reflected in the repository 
Starting Siebel services  - Siebel service should be restarted after importing the 
custom objects 
Enabling CIS Views  - In order to make CIS views visible to the user, these views 
should be enabled and user should be given responsibility to view those. This 
process explains how to enable the views.  
Assigning responsibility to the User – This process explains how to assign 
responsibility to the users so that they can view CIS views. 
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I. From the Start menu of Windows explorer, select Program-> Siebel Tools 
7.0.4->Siebel Tools.  

 
II. Provide valid Siebel credentials. 

III. Select Connect to as Server 
IV. Click on Ok button 
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Importing Custom CIS Objects 

I. In Siebel Tools interface navigate to Tools -> Import from Archive 

 
 

II. Select CIS30Objectss.sif archive file from SiebelObjects subfolder 
under <Systemdrive>:\ProgramFiles\FileNET\CIS3.0 folder. This folder 
is created during CIS 3.0 installation on Siebel server and must exist. 
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III. Click on Open button 
IV. Import wizard screen comes up 
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V. Select option Merge the object definition from the archive file with 
the definition in the repository 

VI. Click on Next button 
VII. Following screen will appear 

 
VIII. Click on Next button. A confirmation dialog box will come up 
IX. To proceed, Click on Yes button 

X. Objects will be uploaded in the Siebel server repository  

Importing CIS Scripts 

I. From Siebel Tools interface navigate to View->Options 
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II. Select Scripting Tab and uncheck Default Language for new scripts 

check box  
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III. Click on OK button. 
IV. From Object Explorer window of Siebel Tool, select object type Project 

 
V. Select Siebel Universal Agent project From Object List Editor window 

in the right pane. 
VI. Lock Siebel Universal Agent project by checking Locked column. 
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VII. From Object Explorer window, select object type Application 
VIII. Select application Siebel Universal Agent From Object List Editor 

window in the right pane. 
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IX. Right click on the selected item and select Edit Server scripts 

 
X. Scripting Language dialog box will appear. 
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XI. Select escript as scripting language and click on OK button. 

XII. From list of application events, select Application_start 
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XIII. Navigate to File->Import 

 
XI. Select CIS30Application_start.js file from SiebelObjects subfolder 

under <Systemdrive>:\ProgramFiles\FileNET\CIS3.0 folder. 
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XIV. Click on Open button. Application_Start function will be populated 

 
XV. Click on Save button. 
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XVI. From Object Explorer window, select object type Project 
XVII. Select Service project From Object List Editor window in the right pane. 
XVIII. Lock Service project by checking Locked column. 

 
XIX.  From Object Explorer window, select object type Business 

Component 
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XX. Select Service Request Business Component from Object List Editor 

window in the right pane. 
XXI. Right click and select Edit server scripts.  
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XXII. Scripting Language dialog box will appear. 

 
XXIII. Select Visual Basic as scripting language and click on OK button. 
XXIV. Select BusComp_PreDeleteRecord event 
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XXV. Navigate to File->import menu 
XXVI. Select CIS30BusComp_PreDeleteRecord.sbl from SiebelObjects 

subfolder under <Systemdrive>:\ProgramFiles\FileNET\CIS3.0 folder. 
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XXVII. Click on Open button 
XXVIII. BusComp_PreDeleteRecord () function will be populated 
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XXIX. Save the changes 

Copying web template 

I. Copy CISCCFormbody.swt file from file from SiebelObjects subfolder 
under <Systemdrive>:\ProgramFiles\FileNET\CIS3.0 folder to < system 
drive > /sea703/siebsrvr/webtempl 

II. Copy CISCCAppletFormPlain.swt file from SiebelObjects subfolder 
under <Systemdrive>:\ProgramFiles\FileNET\CIS3.0 folder to < system 
drive > /sea703/siebsrvr/webtempl 

Note  In order to setup CIS application for dedicated web client, Copy 
web templates to < system drive > /sea703/Client/webtempl 
folder. 

Set CIS VBC as Business Object Component to Service 
Request Business object 

I. Ensure that Service project is locked. 
II. From Object Explorer window, select object type Business Object 

III. Select Service Request Business Object from Object List Editor 
window in the right pane. 
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IV. Expand Business Object node and select Business Object 
Component object from object explorer window 
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V. Right click on Business Object Components panel and click on new 
record. 
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VI. For this record Set parameters BusComp = CIS VBC and Link = 
Service Request/CIS VBC 

 

Adding CIS Views to Service Request Screen 

I. From Object Explorer window, select object type Project 
II. Select Service (SSV) project from Object List Editor window in the right 

pane. 
III. Lock project Service (SSV) 
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IV. From Object Explorer window, select object type Screen 
V. Select Service Request Screen screen from Object List Editor window 

in the right pane. 
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VI. Expand Screen node and select Screen view object from object 
explorer window 

 
VII. Right click on Screen Views panel and click on new record. 
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VIII. Set properties of this new view object as follows 

• Set ‘Category’, ‘Category menu Text’ & ‘Category View bar text’ 
properties of the view object as “FileNET attachments” 

• Set ‘Sequence’ property to 20  
• Set ‘Menu’ and ‘View bar text’ as “View Linked Documents” 
 

IX. Create another view object and Set properties of this view object as 
follows 

• Set ‘Category’, ‘Category menu Text’ & ‘Category View bar text’ 
properties of the view object as “FileNET attachments” 

• Set ‘Sequence’ property to 30  

• Set ‘Menu’ and ‘View bar text’ as “Add Document” 
 

X. Create one more view object and Set properties of this view object as 
follows 

• Set ‘Category’, ‘Category menu Text’ & ‘Category View bar text’ 
properties of the view object as “FileNET attachments” 

• Set sequence property to 40  

• Set ‘Menu’ and ‘View bar text’ as “Query And Link Documents” 
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Compiling the repository 

I. From Siebel Tools interface, navigate to Tools-> Compile projects 

 
II. Select Selected Projects radio button. From the Projects list, select 

CIS3.0Project, Siebel Universal Agent, Service (SSV) and Service 
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III. Click on Compile button. 

IV. Close Siebel Tools application 
V. From windows navigate to Settings ->Control Panel->Administration 

Tools -> services  
VI. Stop Siebel services: Siebel Gateway server and Siebel server 



  CIS 3.0 Installation and Configuration Guide 

October 2002 FileNET CRM Integration Suite 90 

 
VII. Copy repository from the Siebel repository file location to 

sea703/siebsrvr/objects/enu. Siebel repository file location is Siebel 
repository file location selected at the time of compilation 

Starting Siebel services 

I. From Services start Siebel services: Siebel Gateway server and 
Siebel server 

Enabling CIS Views 

I. Run Call Center application by navigating http://servername>callcenter. 

http://servername>callcenter/


  CIS 3.0 Installation and Configuration Guide 

October 2002 FileNET CRM Integration Suite 91 

  
II. Login to Call Center with the valid login credentials 

III. Navigate to View -> Site Map 
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IV. Click on Application administration 

 
V. Click on Views screen under Application administration 
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VI. Add entries for following CIS views by clicking on New Button 
CISAddDocumentView-Service,  
CISViewLinkedDocumentsView-Service  
CISSearchAndLinkDocumentView-Service   

 

 

Assigning responsibility to the User 

I.  Select Responsibility from Show Drop Down 
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II. Create a record CISUser in responsibility view 

III. Add CIS views in the view list and add user name in the user list who 
should get access to CIS views 

 
IV. Logout the call center application by navigating to File->Log Out 
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 7 
Data Migration  

CIS Data migration Tool facilitates migration of data from CIS 2.1 
database to CIS 3.0 database. Supported CIS 2.1 databases are MS 
Access, ORACLE and SQL Server whereas supported CIS 3.0 databases 
are ORACLE 8i and SQL server 2000. 
Before running the data migration ensure that System Administrator has 
already created CIS 3.0 Database by running CIS 3.0 database creation 
script.  
To run Migration Tool, from windows explorer navigate to Start-
>Programs-> CRM Integration Suite 3.0->migration Tool. Following 
screen will appear 

     

 
 

Migration Tool interface consists of 2 panels, one for source database 
entries and the other one for destination database entries.  
In order to migrate data from CIS 2.1 database to CIS 3.0 database, 
populate Source Database panel with CIS 2.1 database details and 
Destination Database panel with CIS 3.0 database details. Check 
Migrate Config tables check box to migrate CIS configuration data and 



  CIS 3.0 Installation and Configuration Guide 

October 2002 FileNET CRM Integration Suite 96 

check Migrate Transaction table check box to migrate CIS transaction 
data.  

Note Ensure that configuration data as well as Transaction data are 
successfully migrated before running CIS 3.0 application. If migration is 
planned in 2 steps, migrate configuration data before migrating 
transaction data. 

Select source database type (CIS 2.1 database type) from Source 
Database Type drop down.  

Selecting ORACLE as source Database 

For source database type ORACLE provide TNS name, User name and 
password 
 

   

Selecting MS Access as source Database 

For source database type MS Access provide DSN name, User Name 
and Password 
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Selecting MS SQL Server as source Database 

For source database type MS SQL Server provide Database Server 
name, Database name, User name and Password 
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Select destination database type (CIS 3.0 database type) from 
Destination Database Type drop down. 

Selecting MS SQL Server as destination Database 

 
 

For destination database type MS SQL Server provide Database Server 
name, Database name, User name and Password 

Selecting ORACLE as destination Database 

For destination database type ORACLE provide TNS name, User Id 
and password 
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Selecting Tables to be migrated 

Specify tables to be migrated by checking appropriate check box. Check 
Migrate Config Tables check box to migrate configuration data and 
check Migrate transaction table check box to migrate transaction data.  
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Transaction data must be migrated either along with the configuration 
data or after configuration data is migrated.  

Note   If rerunning migration process is required, perform it on a new CIS3.0 
database. Rerunning migration process on the populated destination 
database will result in an error. 

In order to migrate data, click on Migrate button. A task bar displaying 
migration status will appear at the bottom of the screen. If both the check 
boxes are checked configuration data will be migrated first followed by 
transaction data.  
After both the migrations are done migration reports will be generated. 

Migration Reports 
At the end of the migration process following reports will be generated  
 
Migration Report – This report lists count of records for all Source tables 
and Destination tables. 
 
Exception Report – This report lists all exceptions that occurred while 
migrating transaction data. Those transaction records that reside in the 
source database but could not got migrated to the destination database 
will be listed in this report.  
 
Following conditions will result in exception for transaction table 
 
� Document class is not configured  
� Business component is not configured  
� Document class and Business Component both are not configured  
 
Once migration process is over, completion message will be displayed. 
Once user clicks on Ok, migration application will be closed. 

 
If any error occurs while migrating configuration data from CIS 2.1 
database to CIS 3.0 database, the whole transaction will be rolled back.  
However, if an error occurs while migrating transaction data, the 
transaction will not be rolled back and application will resume migration 
process whenever transaction migration is rerun next time. 
In order to unload Migration Tool, click on Cancel button 
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Appendix A - Single Sign On 
CIS provides two modes of logon into FileNET libraries. 
 

1. Single Sign On  
2. Explicit logon 

 
In case of explicit logon, CIS application prompts CIS user to provide valid FileNET 
credentials to perform operation on FileNET IS /CS libraries. 
 
In case of ‘Single Sign On’ (SSO), application does not ask for any credential and 
uses FileNET credentials mapped to Siebel user for logon. To implement the 
mechanism FnLDAP.dll and a custom CISLDAP.dll have been used. 
 

Note:   There is no specific configuration for ‘Explicit logon’. If ‘SSO 
Enabled’ is false in CIS configuration that means FileNET logon 
mode for CIS is ‘Explicit Logon’. 
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Appendix B – Software License Agreement 

FileNET End User Software License 
READ CAREFULLY BEFORE INSTALLING. IF YOU DO NOT AGREE WITH THESE TERMS AND CONDITIONS, OR 
THE TERMS AND CONDITIONS IN YOUR SOFTWARE LICENSE AGREEMENT WITH FileNET, DO NOT INSTALL 
THE SOFTWARE. BY INSTALLING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS 
LICENSE.  

1. Authorization of End User 

A Each Software product, including any documentation relating to or describing such Software, such as, but not 
limited to, logic manuals, flow charts and improvements or updates provided by FileNET (collectively called 
"Software"), is furnished to End User under a personal, non-exclusive, nontransferable license solely for End 
User's own internal use in compliance with this License and all applicable laws and regulations. End User agrees 
that this License does not permit End User to: (1) use the Software for a service bureau application or (2) transfer 
the Software without prior written consent from FileNET.  

B End User may make one copy of the Software, (with the proper inclusion of FileNET' s copyright notice and any 
other proprietary notice and/or trademarks on such Software), for End User's own backup purposes; however the 
End User may not otherwise copy or reproduce the Software except to install the Software on a single hard drive 
for use by End User in accordance with this License. 

C If End User is unable to operate the Software on the computer equipment due to an equipment malfunction, the 
Software may be transferred temporarily to other computer equipment during the period of equipment malfunction. 

D Title to and ownership of the Software and all of its parts (or any modifications, translations, or derivatives thereof, 
even if unauthorized) and all applicable rights in patents, copyrights and trade secrets in the Software shall remain 
exclusively with FileNET and its licensors. Software provided hereunder is valuable, proprietary, and unique, and 
End User agrees to be bound by and observe the proprietary nature thereof as provided herein. End User agrees 
to take diligent action to fulfill its obligations hereunder by instruction or agreement with its employees or agents 
(whose confidentiality obligations shall survive termination of employment or agency) who are permitted access to 
the licensed Software. Access shall only be given on a need-to-know basis. Except as set forth herein or as may 
be permitted in writing by FileNET, End User shall not use, provide or otherwise make available the Software or 
any part or copies thereof to any third party. Unless prohibited by law, End User shall not reverse engineer, 
decompile or disassemble the Software or any portion thereof, nor otherwise attempt to create or derive the 
source code. End User acknowledges that unauthorized reproduction, use, or disclosure of the Soft-ware or any 
part thereof is likely to cause irreparable injury to FileNET, who shall therefore be entitled to injunctive relief to 
enforce these restrictions, in addition to any other remedies available at law or in equity. 

E FileNET agrees that affiliates of End User may use the Software; provided that prior to any affiliate's use of the 
Software: (1) each affiliate shall sign and deliver to FileNET a mutually agreeable appendix to this License 
certifying its License to be bound by the terms herein; and (2) such use by such affiliate shall be subject to the 
following: (i) End User accepts responsibility for the acts or omissions of such affiliates as if they were End User's 
acts or omissions; (ii) End User shall indemnify FileNET against losses or damages suffered by FileNET arising 
from breach of this License by any such affiliate as if effected by End User; and (iii) such use shall not constitute 
an unauthorized exportation of the Software or documentation under U.S. Government laws and regulations. 

F FileNET shall defend any action, suit or proceeding brought against End User so far as it is based on a claim that 
the use of any Software delivered hereunder constitutes an infringement of any patent, copyright or other 
intellectual property right, provided that FileNET is promptly notified by End User of the action and given full 
authority, information and assistance for the defense of the action. FileNET shall pay all damages and costs finally 
awarded against End User, but shall not be responsible for any compromise made without its consent. FileNET 
may at any time it is concerned over the possibility of such an infringement, at its option and expense, replace or 
modify the Software so that infringement will not exist, or request the End User to remove the Software involved 
and refund to End User an amount as established by FileNET. 

G FileNET shall have no liability to End User under any provisions of this Section, if any claim is based upon the use 
of the Software in combination with software not supplied by FileNET, or in a manner for which the Software was 
not designed, or if the claim of infringement would have been avoided but for End User's use of Software other 
than the latest unmodified release made available to End User. 

2. Types of Software Licenses 

A For purposes of this License, the following definitions shall apply: 
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1. Server Software is a copy of Software residing on a server or multiple servers. 
2. Clients are personal computers, minicomputers, mainframes, workstations and terminal devices that interact 

with Server Software.
3. Client Software is a copy of Software residing on a Client that interacts with Server Software. 
4. CPU is a central processing unit. A central processing unit can exist as a single instance or in multiple instances 

within a server. 
B End User agrees to license the Software as follows: 

1. For Client Software - one copy of Client Software for each Client that accesses any Server Software. 
2. For Server Software - one copy of Server Software for each server. 
3. For CPU Software - one copy of Software for each CPU on a server containing FileNET Server Software. CPU 

licenses are categorized by performance as outlined in FileNET's CPU Classification Guideline. FileNET will not 
limit end-user to a specific number of concurrent users under this licensing agreement. The number of CPU's 
deployed will be used as a means of calculating the overall system license price. Individual FileNET Systems 
cannot mix CPU Software licenses and FileNET's other Software pricing model, Concurrent User Licenses. 

C FileNET may audit the End User's Software usage remotely or on-site during service calls or upon reasonable 
notice during standard business hours. The audit shall determine Software usage by server for the number of 
concurrent Dedicated, Shared and/or eBusiness User Licenses required for each server. Should an audit 
determine that Customer's usage has exceeded the number of Concurrent User Licenses, or that End User's 
deployment of Software on Clients exceeds the con-tracted ratio of Clients to Concurrent User Licenses, End User 
agrees to purchase additional licenses in compliance with this Software Schedule. For a server with a combination 
of concurrent Dedicated, Shared and/or eBusiness User Licenses, any use beyond the total aggregate number of 
all Concurrent User Licenses (including previously acquired SLU type licenses) will require additional Concurrent 
User Licenses to be purchased. The highest ratio Concurrent User License identified on the End User's 
configuration and its applicable fee will be invoiced accordingly. 

D FileNET may audit the End User's Software usage remotely or on-site during service calls or upon reasonable 
notice during standard business hours. The audit shall determine Software usage by server for the number of 
concurrent Dedicated, Shared and/or eBusiness User Licenses required for each server. Should an audit 
determine that Customer's usage has exceeded the number of Concurrent User Licenses, or that End User's 
deployment of Software on Clients exceeds the con-tracted ratio of Clients to Concurrent User Licenses, End User 
agrees to purchase additional licenses in compliance with this Software Schedule. For a server with a combination 
of concurrent Dedicated, Shared and/or eBusiness User Licenses, any use beyond the total aggregate number of 
all Concurrent User Licenses (including previously acquired SLU type licenses) will require additional Concurrent 
User Licenses to be purchased. The highest ratio Concurrent User License identified on the End User's 
configuration and its applicable fee will be invoiced accordingly. 

3. Termination 

Notwithstanding the foregoing, FileNET shall have the right to terminate End User's authorization to use the Software if 
End User fails to comply with the terms and conditions of the License. Upon notice of such termination, End User shall 
immediately destroy the Software and all portions and copies thereof and, if requested by FileNET, shall certify in writing 
as to the destruction of the same. 
4. Disclaimer and Limited Warranty 

FileNET warrants the media on which the Software is furnished to be free from defects in materials and workmanship for a 
period of ninety (90) days from the date of purchase. FileNET's entire liability and End User's exclusive remedy as to 
media shall be at FileNET's option, either the return of the amount paid for the Software or replacement of the media that 
does not meet FileNET's limited warranty and which is returned to FileNET with a copy of the receipt. 
EXCEPT AS EXPRESSLY PROVIDED ABOVE, THE SOFTWARE AND DOCUMENTATION ARE PROVIDED "AS IS", 
FILENET DOES NOT MAKE ANY AND HEREBY DISCLAIMS ALL WARRANTIES OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 
The entire risk as to the quality, accuracy and performance of the Software and the Documentation is with End User. 
FileNET does not warrant that the functions contained in the Software will meet End User's requirements or that the 
operation of the Software will be uninterrupted or error free. 
FILENET SHALL NOT BE LIABLE UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL 
OR EQ-UITABLE THEORY FOR ANY INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING 
DAMAGES FROM LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
PROCUREMENT OF SUBSTITUTE GOODS OR TECHNOLOGY, AND THE LIKE) ARISING OUT OF THIS LICENSE 
OR THE USE OF OR INABIL-ITY TO USE THE SOFTWARE EVEN IF FILENET HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 
5. Permitted Uses 

This Software and the Documentation are licensed to you, the End User, and may not be transferred to or used by any 
third party for any length of time without the written consent of FileNET. You may not modify, adapt, translate, reverse 
engineer, decompile, disassemble, or create derivative works based on the Software or the written materials. Interface 
information necessary to achieve interoperability is available from FileNET on written request and payment of FileNET's 
then current fee. 
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6. Government Restricted Rights 

The Software is commercial software and the Software and Documentation are provided with Restricted Rights. Use, 
duplication or disclosure by the Government is subject to restrictions as set forth in paragraph (c) (1) (ii) of the Rights in 
Technical Data and Computer Software Clause at DFARS 252.227-7013 or subparagraphs (c) (1) and (2) of the 
Commercial Computer Software Restricted Rights at 48 CRF 52.007-19, as applicable. Contractor/Manufacturer is 
FileNET Corporation, 3565 Harbor Blvd., Costa Mesa, California 92626. 
7. Export 

Regardless of any disclosure made by the End User or licensee to FileNET of the ultimate destination of the Software, 
End User shall not export or re-export, whether directly or indirectly, the Software to anyone outside the United States of 
America without first obtaining an export license from the United States Department of Commerce or any other agency or 
department of the United States Government as required. 
8. Miscellaneous 

This License is governed by the laws of California, without regard to its conflicts of laws, provisions, or the United Nations 
Convention on the International Sale of Goods and will be deemed a contract under seal. If any provision of this License 
shall be held by a court of competent jurisdiction to be contrary to law, that provision will be enforced to the maximum 
extent permissible, and the remaining provisions of this License will remain in full force and effect. This License is not 
assignable or transferable by End User without prior written consent of FileNET; any attempt to do so shall be void. Any 
notice, approval or consent required here-under shall be in writing. The parties agree that a material breach of this 
License by End User would cause irreparable injury to FileNET for which monetary damages would not be an adequate 
remedy and that FileNET shall be entitled to equitable relief in addition to any other remedies it may have hereunder or at 
law, Section 4 shall survive any termination of this License. 
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